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The WP Admin dashboard is where you can manage your website settings, content, and more. The WP Admin dashboard is also known as /wp-admin or the classic WordPress dashboard. Many online tutorials feature the WP Admin dashboard in their appearance, as opposed to the Default View built into WordPress.com. WordPress.com offers two
different dashboards you can use, depending on which one you prefer: The WordPress.com default dashboard WP Admin (considered the classic WordPress dashboard) While you can do almost everything in the default dashboard, you can also switch to WP Admin if that is your preference. This guide will show you how to access WP Admin. WP Admin
is also known as /wp-admin or the classic WordPress dashboard. You will often see images of this dashboard appear in online WordPress tutorials usually with a black left sidebar. Some folks fondly called this the admin area. While you can do almost everything in the WordPress.com default dashboard, you can use WP Admin if that is your preference.
The WordPress.com default dashboard and WP Admin are connected. Therefore, any changes you make on one dashboard will be reflected on the other. You can always access WP Admin by typing your website address in your browsers address bar, followed by /wp-admin. For example: yourgroovysite.wordpress.com/wp-admin or,
yourgroovydomain.com/wp-admin When you firstlog into yourWordPress.comaccount, you will arrive onthe Defaultstyledashboard.To navigate to the WP Admin dashboard from here, follow these steps: Log into WordPress.com. Click on one of your sites from the Sites list. Click on the My Home button. In the Quick links section, click on the WP Admin
Dashboard option.WP Admin Dashboard If you are logged into WordPress.com but unable to log into the WP Admin dashboard, follow thesteps to reset your WP Admin password. You can set your website to use the WP Admin interface (Classic style) whenever you log into your sites dashboard. To update your sites admin interface to always use WP
Admin, follow these steps: Log into WordPress.com. Click on one of your sites from the Sites list. Click on the My Home button. Next, navigate to Settings General. Scroll down to the Admin Interface Style section. Choose between:Classic style: The classic WP Admin WordPress interface. Default style: The redesigned WordPress.com experience. Click
the Save Changes button. After making a selection, your admin interface style will update automatically in a few seconds. The My Home button from step 3 will change to WP Admin going forward. To change the admin interface of any individual screen, follow these steps: Log into your WordPress.com dashboard. Visit the specific dashboard page you
want to change the view for. Click the View tab at the top of your screen. Select between the Classic view and Default view. Change View If you do not have the View tab, verify youre on a page that offers the option to switch views (listed below) and check to make sure WordPress.com Log In is set to the ON position at Settings Security
WordPress.com Log In. Classic view is available for: When you switch to Classic view, it will not change back to the Default view unless you intentionally return to this view using the View tab. You can control the view on a screen-by-screen basis. For example, switching to Classic view on Media will not change the view on the Users screen. Switching
to Classic view on Users is a separate action. If you switch your sites admin interface to always use WP Admin, My Home will be replaced with Dashboard in both your sites dashboard and the main Sites list dashboard. If youre using the default admin interface, you can also navigate to the WP Admin dashboard using one of these steps: Visit My Home
and select WP Admin from the Quick Links menu Append your public site address with /wp-admin The dashboard home screen displays cards of information including: At a Glance: a summary of the content on your site and identifies which theme you are using. Activity: the upcoming scheduled posts, recently published posts, and the most recent
comments on your posts. Quick Draft: quickly create a new post and save it as a draft. It also displays links to the three most recent draft posts youve started. You can click on those links to edit the draft posts or access them by navigating to Posts All Posts Drafts. Site Health Status (plugin-enabled sites only) displays information about your
WordPress configuration and items that may need your attention. Youll also find cards for other features including Stats, Newsletter, Writing Prompts, and any cards added by plugins you have installed. Click on any of the three arrows next to the title in any box to move the current box element up, down, or toggle to shut it. You can also click and
drag any boxes to move them into a different position. All the core pages in WP Admin include the option to choose what columns display, how many items to show (pagination) and whether to show a compact or extended view. These screen options are especially useful if youre viewing your tools from a smaller screen and want to be able to see
specific elements at a glance. Learn how to customize your administration screens with Screen Options.How do I log in to WordPress? is one of the most frequent questions we hear from folks just starting out.Think of your WordPress login page as the doorway to your sites admin area. This is where youll be crafting your awesome blog posts,
designing beautiful pages, tweaking your websites look with themes, and adding cool features with plugins.If youre unable to find the login page, or youre having trouble logging in, this guide is for you.At WP101, weve helped tons of beginners get their WordPress journey underway, and weve noticed that this seemingly simple step can sometimes be
surprisingly tricky.Thats why Ive put together this friendly guide to show you exactly how to find your WordPress login URL and get you back into your admin area in no time.Ill cover the most reliable methods that work across all sorts of WordPress setups, so you can say goodbye to login confusion once and for all. Whats In This Guide?This is quite
an extensive guide so Ive created a table of contents for you to help you navigate to different sections. Heres what Ill cover in this guide: Lets get started. The first step, of course, is finding your way to the login page. The good news is that the standard WordPress login URL is usually pretty consistent across most websites. Ill show you 2 methods
here.Finding Your Default WordPress Login URLThe most common way to find your WordPress login page is to simply add /wp-admin/ to the end of your websites main address.For example, if your website is yourdomain.com, you can usually access your login page by going to:yourdomain.com/wp-admin/Give that a try in your web browser! Often, this
will automatically redirect you to the actual login form.Another very common variation you can try is adding /login/ after your domain name. So, the address would be:yourdomain.com/login/Keep these two simple URL structures in mind they are your go-to methods for reaching your WordPress login gateway.These URLs should take you to the login
page that looks like this:Here, you can enter your username and password and log in to your WordPress admin dashboard which looks like this:In the next section, well explore how to log in through your web host.Logging in Through Your Web Hosting DashboardSometimes, the quickest way to access your WordPress admin area is directly through
your web hosting providers dashboard. Many hosting companies offer convenient shortcuts that can bypass the need to remember or type your WordPress login URL. Heres how you can typically log in through some popular hosting providers:WordPress Login Shortcut in BluehostIf your website is hosted with Bluehost, they often make it incredibly
easy to log in to WordPress.When you log in to your Bluehost hosting account, navigate to the Websites tab on the left-hand side. From there, you can add new sites by clicking on the Add Site button.This lets you add a new WordPress installation and connect a domain or use a temporary domain.Once youve created a site, youll see a list of your
websites in the same Website tab. Now you can click on the Edit Site button and youll be taken to your WordPress login page.All you have to do is enter your username or email address, along with your password, and log in to your WordPress dashboard.WordPress Login Shortcut in SiteGroundSiteGround also provides a quick shortcut to log in to
your WordPress site. Once youve logged into your SiteGround hosting dashboard, youll need to click on the Websites tab at the top. This will display a list of the websites you have installed on your hosting account.Next to the website you want to access, you should find a WordPress Admin button. Simply clicking this button will log you into your
WordPress admin panel.WordPress Login Shortcut in WP EngineWPEngine is known for its managed WordPress hosting, and they offer a seamless login feature. After logging into your WP Engine account, this feature thats labelled WP Admin will take you directly to your WordPress admin page without any additional steps.These hosting dashboard
shortcuts can be particularly useful if youve forgotten your WordPress login details or if you simply prefer a faster way to access your sites backend.Keep in mind that the exact steps and wording might vary slightly depending on your hosting providers interface, but the general principle of logging in through your hosting account remains the same
for many providers like Hostinger as well.In the next section, well cover what to do if you encounter any issues while trying to log in to your WordPress site.What to Do If Youre Having Trouble Logging InEven with the standard methods and hosting shortcuts, you might occasionally encounter difficulties when trying to log in to your WordPress site. In
most cases, the best course of action is to contact your web hosting support.That said, here are some common issues and steps you can take to troubleshoot them:Incorrect Login Credentials: The most frequent reason for login failure is simply entering the wrong username or password. Double-check that youve typed both correctly, paying attention
to capitalization and any accidental spaces.If youve forgotten your password, WordPress has a Lost your password? link on the login page that you can use to reset it via email.Page Not Found or Other Errors: If youre entering your login URL and are met with a Page Not Found error or another unexpected message, there could be a few reasons:Typo
in the URL: Ensure that youve typed the URL (/wp-admin/, /login/, or /wp-login.php) correctly. If your WordPress site is installed in a subfolder (e.g., site.com/blog), make sure to include the folder name in the login URL (e.g., site.com/blog/wp-admin/).Issue with Website Files: In rare cases, core WordPress files, including the login script (wp-
login.php), might be corrupted or missing. This requires more technical help. I suggest contacting your hosting provider.Hosting Issues: Sometimes, problems with your web hosting server can prevent access to your site. Again, contact your web hosting support for this.Site Not Connected to Database: If you see a message indicating that your site is
not connected to a database, this prevents login. You may want to check with your hosting provider to ensure your wp-config file is set up correctly.Conflicts with Plugins or Themes: Occasionally, a poorly coded plugin or theme can interfere with the login process. This is why its important to use reliable plugins on your site. Also, test out new plugins
on a staging website before you add it to your live site.If you suspect this, the best way to fix this is to access your sites files via FTP (File Transfer Protocol). You need to go into your wp-content folder. Then temporarily deactivate all plugins by renaming the plugins folder to something like plugins old.If you can then log in, reactivate your plugins one
by one to identify the culprit. Heres a detailed guide on how to use FTP to deactivate plugins and troubleshoot the error.Issues After a Hosting Change: One of our users recently faced this issue because they had transferred their domain to another host. If you suspect its the same issue, you need to ensure that the DNS records for your domain are
correctly pointing to your new hosting server.If you arent sure how to do this, connect with your hosting support.URL Redirects to a Different Site: If your /admin URL is redirecting to an unexpected website, as one user experienced, this could mean your website has been hacked. Jump to our guide onHow to Fix a Hacked WordPress Website.In case
it is not a hacked site, then its an unusual issue that would require contacting your hosting provider for assistance.If youve tried these basic troubleshooting steps and are still unable to log in, reaching out to your web hosting providers support team is generally the next best course of action. They can help diagnose server-level issues or problems
with your WordPress installation.Next, Il1l show you how to create a custom login page with its own URL. The default WordPress login page is generic and can seem boring to users.Creating a custom login page can change that giving the user a new experience on your WordPress website. It brings about consistent branding, improved user trust,
promotional opportunities, and a better user flow.Heres a custom login page I set up in 5 minutes.You can do this with SeedProd.SeedProd is a powerful drag-and-drop landing page builder for WordPress. The reason I picked SeedProd is that it makes it so easy to create fully custom login pages with professionally designed templates. You can
customize pretty much every element of the page.If you have a membership site, online store, or any site that allows users to log in, then having a custom login page with your own branding would be beneficial. It makes you look professional and increases your brand visibility.SeedProd also allows you to redirect the default WordPress login page to
the new page you create.Not convinced? Heres what I think youll love about this builder:Theres an easy to use drag and drop visual page builder.You get professionally-designed login page templates that act as a starting point for your design.It lets you customize every element, including backgrounds, colors, text, and layout.You can add various
blocks including images, videos, social profiles, and more.Theres an option to redirect the default login page to the new URL which enhances security by making it harder for bots to find the login area.You can connect to your email marketing services which his great if you want to collect emails on your login page.Theres a WooCommerce integration
thats useful for eCommerce sites.Heres how you can create a custom login page using only the SeedProd plugin, based on the sources:Step 1. Install and Activate the SeedProd PluginFirst, sign up for a plan on the SeedProd website. Once done, you can log into your SeedProd account where youll see a license key and an option to Download SeedProd
Pro.Copy the license key and download this file to your computer.Now you can head over to your WordPress site and upload the plugin file under Plugins Add New Upload Plugin.For detailed instructions, you can refer to our guide on how to install a WordPress plugin.Upon activation, you should see a welcome screen where you need to enter your
product license key.After entering it, youll need to verify the key.Step 2. Create Your Login PageGo to SeedProd Landing Pages in your WordPress admin sidebar. Click the Set up a Login Page button.You will be taken to a screen with various professionally-designed login page templates. You can choose one of these templates or select the Blank
template to build a page from scratch.Simply hover over a template and click the check icon to select it.Now a popup will appear where you can name your new login page and enter a custom login page URL.Click the Save and Start Editing the Page button.3. Customize Your Login PageYoull be taken to SeedProds drag-and-drop page builder
interface.The left side has blocks and sections you can add to the page, and the right side shows a real-time preview.First, you can add new content using the ready-made landing page blocks such as images, videos, buttons, social profiles, and more. Simply drag and drop them into the design preview.You can customize existing elements by clicking
on them. Editing options for each field will open up on the left.SeedProd also offers pre-built sections like Features, FAQ, and Footers.Plus, you can adjust the background, fonts, and colors of your entire login page in the Global Settings.Remember to save your changes at each step.When youre done customizing your page, we can move on to the next
step.4. Configure Login Page SettingsNavigate to Page Settings in the top menu.Under the General settings, you can change the login page name and URL. Scroll down and find the Redirect the Default Login Page option and enable it by clicking the toggle. This will redirect users who try to access the default WordPress login page (wp-admin or wp-
login.php) to your new custom login page.Next, under the Access Control tab, you can determine who can view and use this page. You can grant access by IP address and WordPress role.Now all thats left to do is click the arrow next to the Save box and select Publish from the dropdown.After publishing, youll see a success message. Exit the visual
builder and go back to the main SeedProd dashboard. Under the Login Page section, toggle the button from Inactive to Active.Now you have a visually appealing and branded login page that offers a much better user experience compared to the default WordPress login screen.Next, you can also add login and registration links to your WordPress
website. I use the WPForms plugin and its User Registration addon. Theres a variety of pre-built templates that you can use to create your login and registration forms. These templates cover different styles and layouts, so you can find one that matches your purpose.Heres a registration form I created in just 2 mins with WPForms:It has a simple
interface that even beginners can understand. You dont need to be a tech expert to create great forms.Learn how to create a custom user registration form in WordPress using WPForms.Next, Ill answer questions users frequently askFAQs on WordPress LoginHow do I log in to my WordPress site?Go to the login page at yourdomainname.com/wp-
login.php or /wp-admin. Make sure your replace yourdomainname with your actual domain name.What is my username and password?Your username and password are the same as the ones you created when setting up your WordPress site. If youve forgotten your password, click on the Lost your password? link on the login page to reset it. How do I
remember my password?To make it easier to remember your password, consider using a password manager to generate and store unique passwords for each of your WordPress sites.Can I log in from anywhere?Yes, you can log in to your WordPress site from anywhere with an internet connection. Just make sure you have the correct username and
password.What if Im having trouble logging in?If youre having trouble logging in, try checking that your username and password are correct, and that youre using the correct login URL. If the problem persists, contact your web hosting provider or a WordPress expert for assistance.How do I log out of my WordPress site?Hover over your profile
picture at the top right corner of the dashboard. Youll see a dropdown menu appear with an option to Log Out.I hope you found this post helpful.New to WordPress? Or maybe youre looking to take your website to the next level? Weve got you covered. Our comprehensive video tutorials have helped thousands of users unlock WordPresss full potential.
From basic setup to advanced techniques, well show you exactly how to make WordPress work for you.Get started with WORDPRESS 101 Theres a 7-day free trial along with a 14-day no risk money back guarantee so you can join with peace of mind and start learning today. WordPressWordPress WordPressWordPressWordPressWordPress
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way to access your WordPress Login URL will be in this format: You can also log in from: For example, for a new WordPress installation, you can visit yoursite.com/wp-login.php or yoursite.com/wp-admin to login. It might be helpful if you bookmark your sites login URL. From your WordPress login screen, youll enter the username and password that
you set up during the WordPress installation process. If youve forgotten your WordPress login password, you can click the Lost Your password? link to retrieve it via email. Back to What is WordPress? $199 per year20 GB Included storage Are you having a hard time finding your WordPress login URL? Maybe you just installed WordPress on your
domain, but cant figure out how to login to your website. If so, you have nothing to be worried about. In this post, we will show you how to login to WordPress via the admin URL. Additionally, we will be showing you how to customize your websites admin URL and even hide it if you wish to. Lets get to it, but first the table of content: What is
WordPress Admin URL?How to find the login URL for a subdomain or subdirectory websitel keep forgetting my login URL and credentials?How to change your WordPress Login URLHow to limit the number of login attemptsDealing with cookies issuesConclusion Every WordPress website comes with an admin area. This is where you get to control
and manage your website. Think of it as your dashboard. But to gain access to this dashboard, you need to find your WordPress admin login page. It looks like this: But how do you find this login page? Simply by typing your login URL in the browser. So, the login URL which is the same as the admin URL is the link you type in a browser to locate your
websites admin login page. This link takes different forms but has the same structure. You create it by appending any of the following to your websites URL: adminwp-adminwp-login.phplogin.phpFor example, lets assume that your websites URL is www.mywebsite.com Your WordPress login URL can be any of these:
www.mywebsite.com/adminwww.mywebsite.com/wp-adminwww.mywebsite.com/wp-login.phpwww.mywebsite.com/login.php What if your website is hosted on a subdomain or subdirectory, what form will the login link take? Now, before answering that question, lets first make clear what a subdomain and subdirectory are. Subdomains and
subdirectories, as their name suggests, are websites that are subsidiaries of the main website. The only difference is their structure. Subdomains are created prepending a name to the main domain. Eg: blog.mywebsite.com Whereas a subdirectory is created by appending a name with a forward slash to the main domain. Eg: mywebsite.com/blog For a
subdomain, you find the login URL in the same way as you would for a regular website: blog.mywebsite.com/wp-adminblog.mywebsite.com/wp-login.phpAnd for subdirectory mywebsite.com/blog/wp-adminmywebsite.com/blog/login.php What if for some weird reason you cant seem to remember your login URL? Well, there are a couple of solutions to
that. The simplest of them is bookmarking the login link and opening it whenever you need it. To do so on Chrome, hit Ctrl + D (on Windows) or Cmd + D on the Mac to bookmark the page. For your login credentials, one easy way to remember it is to check the Remember me box like so: But what if youve forgotten your password and the remember
me function isnt helping? If thats the case, click the Lost your password link as seen in the screenshot above. A password reset link and instruction will be sent to your email. Its then up to you to do the needful. Has it dawned on you by now that just about anyone can find your WordPress login page? All they need to do is to append wp-admin to your
domain URL, and your login page will show up. Do you know the implication of that? A hacker, or anyone with a malicious motive, can easily log in to your WordPress website of yours. Thus, to keep your website from the reach of hackers, you might want to change your login URL. Or even hide it altogether. There are two ways to go about this:
manually and via a plugin. We will be covering both shortly. To manually obscure the link to your login page, you will need to locate your websites wp-login.php file. This is where your sites login credentials are stored. Once youve found it, edit and upload it, and you are all set. Of course, thats just a quick summary. Lets now get into details. Step #1:
Download the wp-login.php file You will first need to login to your cPanel. Once logged in, click the File Manager icon. Note: your cPanel interface might be different from the one you see above, but will surely have the same structure. Next, open the public html folder. Once youve opened it, scroll down a little until you find the wp-login.php. Click it
and then the Download link like so: After downloading the file, right-click the wp-login.php file and delete it. Now open the downloaded file with any text editor: Visual studio code or Notepad ++ will do. What you will want to do next is to replace all instances of wp-login with the new URL you want. For example my-url. The easiest way to do this is to
run a find and replace function by hitting the Ctrl + F keys. After the replacement, save the file with the name you used as a replacement. For example, in this case we would save it as my-url.php After the replacement, save the file, and upload it back to your file manager by clicking the Upload link. Next, test if the new login URL is working by typing
it in your browser: mywebsite.com/my-url.php If you did everything well, the login page should come up. Why take the stress of changing your login to WordPress URL manually when a plugin can do it seamlessly? WPS Hide Login is one plugin you can bank on to get the job done. You can use it to hide, or, if you want, change your websites login URL.
To use this plugin, first install and activate it on your website. Next, navigate to Settings >> WP Hide login On the WP Hide plugin page, scroll down a little until you find the Login url input field. This is where you will type in the new WordPress login URL you want to use: What if someone tries to log in to your dashboard via the standard login URL?
By default, such a person will be redirected to your 404 page that is, page not found. But if you dont want this, replace 404 with the URL of your preferred redirect page. When you are done, hit the Save Changes button. Maybe changing the login URL to your website makes you a bit uncomfortable. Or, perhaps, you want to add an extra layer of
security to your website even after changing the login URL. Limiting the number of login attempts to your website will go a long way to help. This time around you wont be editing your websites codes but will use a plugin instead. And the plugin we recommend is Limit Login Attempts Reloaded Ordinarily, WordPress allows unlimited login attempts,
thus making your website susceptible to a brute force attack. This happens when someone tries to forcefully gain access to your website by guessing your password. What Limit Login Attempts Reloaded does is to block the IP address of anyone that makes multiple, unsuccessful attempts to login into your website. To use, install and activate the
plugin. Then navigate to Settings >> Limit Login Attempts Then set the lockout notification email, maximum number of login attempts, lockout duration, etc. Dont forget to save changes. For WordPress to work well, cookies need to be enabled on your browser. If it is not, you will encounter a login error. It looks like this: If you are currently
experiencing this problem or whenever you do to fix it, you will have to enable cookies on your browser. Thats a no-brainer! To enable cookies on Chrome, click on the 3-dot icon at the top-right corner, followed by Settings. Next, navigate to Privacy and security >> Cookies and other site data. Then check the Allow all cookies data checkbox. And
thats it. For Internet Explorer and Mozilla Firefox, the steps are almost the same. Keeping your WordPress website away from the reach of hackers is one step in the right direction. And one easy way to do that is by making your WordPress Login URL inaccessible. In this post, weve shown you how to find your admin URL and also how to hide it
manually and with a plugin. Logging in with your WP login URL is the only way to access your sites admin panel or WordPress dashboard. The dashboard is where you can customize your pages, or install plugins and update the theme. But, if youre new to WordPress, you will need to learn how to log in. Its also possible that you changed your URL, in
the name of security, and forgot it. We at MalCare, do not recommend changing the login URL, for this reason. But, all is not lost. In this article, well show you how to find the default WordPress login URL and what to do if youve lost your URL. Well even give you some better advice on login security. TL;DR: Add /wp-login.php/ or /wp-admin/to the end
of your domain name to find your default login URL. If youve changed your URL and lost it, disable the plugin using an FTP client and then use the default login URL to access your site. For those new to WordPress, finding the default WordPress admin login URL can be a bit confusing when setting up a website. Luckily, the default login URL is a
standard format. Type your URL and add one of the following to the end: /wp-login.php/ /wp-admin/ So, if your site URL is mywebsite.com, for example, then the login URL is mywebsite.com/wp-login.php/ You can use mywebsite.com/wp-admin/ to access your admin dashboard. If you are logged out, you will be automatically redirected to the
WordPress login URL. If your WordPress is installed in a subdirectory, add it after the closing slash of the subdirectory. Lets say your main domain is mywebsite.com and youve installed WordPress in a subdirectory called blog. The default login URL would be:mywebsite.com/blog/wp-login.php/ You can also access the WordPress login page URL
through your web host. Take Cloudways, for instance, where the process is as follows: Go to the Applications tab at the top of your Cloudways dashboard. Scroll down until you find the specific application (your WordPress site). Click on it, and youll be redirected to the Access Details section. In the Admin Panel section, find the link provided this is
your login URL. Simply click on it to log in. Some hosts like Namecheap uses Softaculous. Softaculous is a popular auto-installer for web applications, including WordPress. Here are the steps to log in to the WordPress admin panel using Softaculous: Log in to your hosting control panel. Look for the Softaculous Apps Installer icon or section. Its often
at the bottom.In the Softaculous interface, find the WordPress icon. Click on the WordPress icon, and youll be taken to the WordPress overview page. Then, head over to the tab that lists all your installations. Find the right installation and click the admin icon. Souce: Namecheap You will now be able to login with your admin credentials. As we
mentioned earlier, the default WordPress login URL is a standard format and this is common knowledge to both regular users and hackers. In most WordPress security or hardening articles, you will see people jumping to the most simplistic conclusion: the login URL is not secure, and susceptible to brute force attacks because the format is well-
known. You may notice a lot of failed login attempts, for instance. However, the solution is not to change the default WordPress login page. This is poor advice given by numerous people who have a misguided sense of security. There are two reasons why this advice is bad: The login page is not the only way to log into a WordPress site. There is also
the XML-RPC function, and any other administrative plugin that can manage your site remotely. If the login is changed and then misplaced, it is very tricky to retrieve. You could be locked out of your site for an inordinate amount of time. Instead, we recommend a list of login security measures like limiting logins, WordPress 2FA, or passwordless
login. But, most importantly, we recommend you install a security plugin like MalCare that instantly installs a powerful firewall that can block all bots or malware attacks. While logging into a WordPress site is a fairly simple process, sometimes things do not go your way. The page may be hard to find, you may forget the login credentials, you might
get redirected to a strange page, and many more issues can crop up. This can be terrifying but its fixable. There is no easy way to find the URL; you may just have to revert the changes you made to the URL. This could mean either restoring a backup you took before changing the URL or deactivating the plugin you used to change the URL.To do this,
get the following FTP credentials from your hosting platform: username, password, and IP address. Then, install Cyberduck or FileZilla. Connect to your server using the credentials. Open the public html folder, followed by the wp-content folder, and then the plugins folder. Finally, rename the folder of the plugin youd like to deactivate. If the login
URL was changed manually by a developer, it was a multi-step process. You may be able to use a trial-and-error method to find the new login URL, by downloading a fresh installation of WordPress, and comparing all the site files. The default installation has a wp-login.php file, and your site shouldnt have the corresponding one in the files. Whether
youre an admin or any other type of user, there are many ways to create new credentials. It could be as simple as using the Forgot Password link or an Emergency Password Reset Link. If a 2FA plugin, for example, isnt letting you log in, we recommend you deactivate the plugin using an FTP client. Sometimes, certain plugins may not be compatible
with your current WordPress theme. In this case, we recommend that you restore a backup or deactivate the plugin using an FTP client. You may need to deactivate the plugins one at a time to figure out which one is causing the issue. When deactivating themes, be careful not to deactivate the active theme. An active theme is required for WordPress
to load, and without it, the site will crash. This is usually a sign that your site has been hacked. We have a detailed guide on fixing the redirect hack that can help. Your site also might be redirecting because of a corrupt .htaccess file, whichcould be caused either by a malware hack or by mistakes made when manually editing the file. Either way, the
fix for this issue is to replace the .htaccess files contents. Connect to your server as usual, then find the file and download it. Open the file on a text editor, delete its contents, and replace it with the WordPress default code: # BEGIN WordPressRewriteEngine OnRewriteBase /RewriteRule ~index\.php$ - [L]RewriteCond %{REQUEST FILENAME} !-
fRewriteCond %{REQUEST FILENAME} !-dRewriteRule . /index.php [L]# END WordPress Next, save the file and reupload it using your FTP client. Make sure to backup your site before making any changes. Please note: We recommend getting your site developer to make these changes, as replacing the .htaccess file contents with the default code
can inadvertently make other changes to your site. If you still find yourself locked out of your WordPress site, it may be due to a corrupted wp-login.php file. Another sign of a corrupted file is that your admin panel is throwing up a 403 error. There are several steps to troubleshoot and resolve the issue. Download the version of WordPress installed on
your site, and use it to reinstall your sites core files. Here is how you do it: Go to WordPress.org/download Download the right version of WordPress Use a file extraction tool to open the downloaded ZIP file. Inside the extracted WordPress folder, find files corresponding to the .htaccess and wp-login.php file Connect to your server using an FTP client
like Cyberduck. You can find the credentials username, password, IP address with your web host account Navigate to your root folder and look for the .htaccess and wp-login.php files. The .htaccess file may be a hidden file Then, upload the fresh files to your site and replace the corrupt ones Check your site when youre done Another strategy involves
switching to a default WordPress theme or deactivating plugins by renaming the plugins folder in wp-content. This helps identify potential conflicts or issues with the active theme or plugins causing the login problem. The WordPress default login URL is standard across WordPress installations /wp-admin or /wp-login.php at the end of the domain.
This makes it easy to remember or find for admins or users. But, its also easy for hackers to find your login URL, making it vulnerable. Theyre susceptible to brute force attacks, risking the security of your website data. This is why we recommend installing a security plugin like MalCare that takes care of WordPress security so you dont have to. It
comes with a robust firewall, a thorough scanner for malware, one-click malware removal, and a whole host of security features that make managing WordPress security easy. What is the typical WordPress login URL? The typical login URL for WordPress is /wp-login.php/ appended to the end of your domain name. Its the standard path to access the
login page and enter your websites admin dashboard. What is a login URL? A login URL is the web address or path you use to access a websites login page. The login URL leads to the page where you can enter your login credentials to access the admin dashboard. How do I view my WordPress login log? To view your WordPress login log, you need to
use a security plugin like MalCare which provides login activity logs, showing details such as login attempts, successful logins, and failed logins. How do I change the WordPress admin login URL? We do not recommend that you change it. But, here is a comprehensive guide on how to change your default login URL. What should I do if I forget my
WordPress login URL? If you forget your WordPress login URL, you can typically find it by adding /wp-login.php/ or /wp-admin/ to the end of your domain name. If this doesnt work, check with your hosting provider or use an FTP client to try other troubleshooting steps. Are there security benefits to changing the login URL? There are no great security
benefits to changing the login URL of a WordPress site. While it makes it harder for hackers to find the login page, it is also difficult for genuine users to find it. This is why we recommend adding other WordPress security measures like limiting logins or passwordless logins. Are there any risks associated with changing the login URL? Yes. First, there
is a risk of compatibility issues with plugins and themes that may assume the default login URL. Secondly, the potential of getting locked out of your own site exists if you forget the custom login URL or encounter problems during the change. Additionally, while altering the login URL can deter some automated attacks, determined attackers might still
discover the new URL, and its not a foolproof method against sophisticated brute-force attacks. This is why we dont recommend changing the URL. Can I revert to the default WordPress login page after changing it? Yes. You will need to deactivate the plugin that helped you change your WordPress login URL. If you can log in, use your dashboard to
do this. If you cant log in, start by connecting to your server using an FTP client. Then, navigate to the wp-content folder, which will be in the public_html folder or your root folder. Then, find the plugin folder that you want to deactivate. Change the name. This could be as simple as adding the word deactivate to the end of the plugin name. Please
register or sign in to access the course content. Found a typo, grammar error or outdated screenshot? Contact us. Are you new to WordPress and wondering how to login to WordPress? Or have you forgotten your WordPress user login credentials? Then, this guide is for you. Without logging into your sites WordPress dashboard, you wont be able to
do anything. Its where all the magic happens. There, you can add, manage, and control your content the way you like! Thats the reason, its important to keep your WordPress login URL safe and secure. To guard your site against hackers and malware. So, in this guide, well explain how to find your WordPress login URL and how to sign in. Well also
show the ways to protect your WordPress login security. Lets start! Prefer watching a video instead? Heres a complete video guide on how to login to WordPress. Video Tutorial How to Login to WordPress? Nevertheless, keep reading if you prefer a written tutorial! First, lets have a quick look at what a WordPress login is and its significance. After
installing WordPress, the first thing you would like to do is log in to WordPress. For that, you should find your WordPress websites login page. A WordPress login page is a door that keeps you from accessing the management dashboard of your WordPress site. What is WordPress Login? Once youve logged in, youll come across your dashboard. The
WordPress dashboard is the main admin area from where you can add content, change your templates, and add plugins. It also lets you make other customization to your site. So, creating and customizing a site would be impossible if you cant log into your dashboard. Hence, its crucial that you know your WordPress login URL and have the login
credentials. As were talking about the login page, two user login credentials make it possible to access the admin area. They are username and password. Hence, remember these two fields and keep them safe somewhere where nobody else can have access to them. Always remember that WordPress admin login credentials are set during the
WordPress installation. Now, lets see how to find your WordPress login URL and log in. Logging in to WordPress is pretty simple. Enter your site address or the domain name in your browsers address bar. Add /wp-login.php at the end of your sites URL and load the page. For instance, if your domain is www.example.com, then your website login URL
is www.example.com/wp-login.php. Once you load your login URL, youll find your WordPress login page that looks like the screenshot below. WordPress Login Page Alternatively, you can also add /login/ or /wp-admin/ at the end of your WordPress site URL to log in. Hence, a WordPress login URL can look like any of the examples below.
www.example.com/wp-login.php www.example.com/login/ www.example.com/wp-admin/ These URLs will take you to your WordPress login page from where youll enter your username and password. Then click the Log In button. Thats all, now youll be logged in! Once logged in, youll reach the admin dashboard of your site. It looks like the screenshot
below. WordPress Dashboard If you dont see the dashboard, then you can also access the admin page by entering these URLs: www.example.com/admin/ www.example.com/wp-admin/ Once you find the WordPress admin dashboard, you can start using it. Like customizing your website settings, changing themes, adding plugins, creating content, and
publishing them. The above method for WordPress login is helpful when WordPress is within the root of your domain. Meaning when the main domain uses WordPress. But if youre using WordPress only for a subdomain, then youll have a different login URL. A subdomain is an additional part of your main domain that organizes and navigates to
different pages of your website. You can create multiple subdomains on your main domain. For instance, if your domain name is www.example.com, then you can have subdomains like these: www.store.example.com, www.blog.example.com, www.uk.example.com, etc. Now, if your WordPress site is on a subdomain, then you should add /wp-login.php
after your subdomain URL to log in. For instance, if your WordPress site subdomain is www.store.example.com, then your login URL will be: www.store.example.com/wp-login.php. WordPress Login on a Subdomain Hence, the login URL for WordPress on a subdomain can be like below. www.subdomain.example.com/wp-login.php
www.subdomain.example.com/login/ www.subdomain.example.com/wp-admin/ A subdirectory is a part of the URL that houses a particular subset of content. In other words, its a child directory that stays under the parent directory as a subfolder. Subdirectories or subfolders are the most straightforward way to organize related pieces of your sites
content. Also, theyre useful if you like to style a section of the same site differently. For example, if you want a Blog section on your website, then you can place the blog as a subdirectory. So if you wish a different design for your Blog page from that of the root directory then, you would like to install WordPress separately and apply the desired theme
to it. So, if your main website address is www.example.com, then you can have a subfolder www.example.com/blog/ with a different WordPress installation. To log in to WordPress on a subdirectory, you can add the /wp-login.php to your subdirectory URL. For instance, www.example.com/blog/wp-login.php. WordPress Login on a Subdirectory
Likewise, you can also add /login/ or /wp-admin/. So, your WordPress login link for the subdirectory would be like the below: www.example.com/subdirectory/wp-login.php www.example.com/subdirectory/login/ www.example.com/subdirectory/wp-admin/ Honestly, we tend to forget our WordPress login link, and then we start pulling our hair to
recollect where wed have saved it. And once we cant remember it, we start babbling around like a wild GOAT! One of the easy way to remember your WordPress login URL using your browsers Bookmark feature. This saves your login URL as a bookmark. Most of the web browsers today have this facility. Here are the required steps for the respective
browsers youre using: Chrome: Click on the Bookmark/Star icon at the end of the address bar. Or, simply press Ctrl + D. Or go to Options > Bookmarks > Bookmark this tab. Safari: Go to Bookmarks > Add Bookmark. Or, hit Cmd + D. Firefox: Go to the star located at the right end of the address bar, so that itll turn blue. Adding WordPress Login
Page as Bookmark on Chrome Once youve bookmarked your login URL, you can directly access the link to your sites login page. That too without having to remember your WordPress login URL off the top of your head. Sometimes, even after you somehow remember your login URL, theres a high chance that you might also forget your password. So to
deal with it you can use Remember Me. On your WordPress login page, you may have seen a checkbox labeled Remember Me just under the username and password field. Check that box before you log in. Itll then save your username and password for up to 14 days and allow you to remain logged in without the necessity to log in on your subsequent
visit. Remember Me option Another easy and secure way to save your WordPress login credentials is by using a password manager tool. For example, you can use LastPass. Visit the website and create an account. After that, you can add its browser extension to your web browser and save your passwords on it. The LastPass extension is available on
all major browsers including Google Chrome, Edge, Firefox, etc. Once saved, itll provide you the username and password every time youre on the login page. Using LastPass to Save Your WordPress Login Details Prefer watching a video instead? Heres a complete video guide on how to protect your WordPress login security. Video Tutorial How to
Protect Your WordPress Login Security? Yet, keep reading if you prefer a written tutorial! Its very important to protect your WordPress login page. If you dont, then others can steal user information, install malicious software, and even distribute malware to your users. This could cause severe damage to your business and reputation. There are
several ways in which you can secure your WordPress login page. Ultimately, this secures your website overall. Hence find the methods: Simple yet most effective way to protect your WordPress login page is to use strong password. It means creating a difficult password that hackers cant easily guess or know. A strong password should have a
minimum of 15 characters. And the combination should contain uppercase and lowercase letters, numbers, and symbols or special characters like &, @, $, etc. Strong Password You can combine the said character types and create strong passwords yourself. Or use online tools to generate strong passwords. If youre using a password management tool
like LastPass, you can also find that feature. For example, check the image below in which we show how to generate strong password with LastPass Chrome extension. Generating Strong Password with LastPass Chrome Extension Plus, there are tools such as Strong Password Generator that would automatically generate the password for you. Just
like in the image below, you only need to set the password length and kinds of characters you want in your password. Strong Password Generator Most people seem to use simple and short passwords for their websites. As they find it easier to remember it and may sometimes use the same password for every other account. But this is often not a good
practice to follow because it makes the job of the hacker so much easier. Hence, you need to always create a really strong password to secure a login page. See the image below to find out what a strong password is and what is not. Nowadays, hackers attempt to hack into your website by guessing some combination of usernames and passwords. Such
types of attacks are called brute force attacks. To protect your website from such attacks, you can limit the number of login attempts on your WordPress login page. Its a very simple and straightforward yet highly effective way of keeping your website secure. For example, you can set users to have three chances to enter the credentials correctly. If
they fail in three attempts, then they might be locked out of their account. You can implement this feature using different WordPress security plugins. Here, lets see how you can enable this on the free Wordfence plugin and Solid Security plugin. If you havent installed the Wordfence plugin, install using this tutorial. After youve installed the plugin, go
to WordPress >> All Options from your WordPress dashboard. Then, find the Brute Force Protection tab on the page. Open the tab and youll see options like shown in the screenshot below. Brute Force Protection Options on Wordfence Security Plugin Step 1: Enable brute force protection by clicking the On option. Step 2: Set the number of login
failures after which users get locked out. Additionally, you can also set the number of forgot password attempts, the amount of time a user is locked out, etc. Step 3: Save your changes. Then you can go to your login page and try it yourself. Solid Security is yet another powerful all-in-one WordPress security plugin. It provides you with different login
security features. First of all, go to the Security >> Firewall page from your WordPress dashboard. After that, click on the Configure tab. Next, go to Local Brute Force and then enable the option by clicking the toggle. Brute Force Protection Settings by Solid Security After that, you can see the number of maximum login attempts per IP, per user, and
minutes to remember bad login. With these settings, you can control brute-force attacks by hackers. Also, there are other plugins like Login LockDown and Limit Login Attempts Reloaded to assist you with similar options. Unless youre using any exclusive feature on these other plugins, using an all-in-one security plugin like Wordfence is a better
option. For beginners, read guides on what a WordPress plugin is and how to install a WordPress plugin! Another thing youll do is upgrade your website to HTTPS. You can do so by adding an SSL certificate to your websites domain. SSL Enabled Secure Site Example SiteSaga When you upgrade your website to HTTPS, itll automatically keep the
hackers far away from going to your website. Thats because it encrypts a connection between your server and your browser. Hence, this encryption makes it harder for hackers to appear around and steal your personal information. Not only that itll also solve your site showing not secure on the web address bar issue. Heres a list of the best website
hosting providers with free SSL for a secure connection. Two-factor authentication is a two-step verification thats used to protect your online account from unauthorized access by adding a layer of security. Once you have 2FA enabled on your site, just having your login username/email and password wont allow you login access. You should also enter
another set of codes for authentication. Hence, its called 2-step verification. So, even if a hacker guesses your credentials, theyd still have to enter the one-time code to access your site. And thats just available to you. Hence, its a secure way to protect your website. You can easily set up two-factor authentication on your WordPress login using security
plugins, like Wordfence and Solid Security. Go to your WordPress dashboard and navigate to Wordfence >> Login Security. After that, you can see a 2FA setup screen just like below. Two-Factor Authentication for WordPress Login using Wordfence Step 1: Scan the QR code shown above with the Google Authenticator app on your mobile device.
Install the app if you dont have it already. Once you scan the code, your app will start generating codes. Step 2: Enter the code generated by your Authenticator app in the field above (123XXX entered as an example above). Then, click the Activate button. You can also download the backup codes and place them safely on your local device. Once the
above steps are complete, you can visit your login page again and see whether 2FA is enabled. For more details, check this documentation. Solid Security plugin also lets you add Two-Factor Authentication to protect your WordPress user login page. To enable the setting, go to Security >> Settings from your dashboard. After that, click on the
Features tab and then Login Security. Youll see the Two-Factor option, enable that using the toggle. Enable Two-Factor Authentication Setting in Solid Security Once the Two-Factor setting has been enabled, you should set up the authentication for your WordPress user profile. Go to the Users >> Profile page from your dashboard. Scroll down to the
Security section at the end and then click on the Two-Factor Authentication tab. Configure Two-Factor Authentication for Your WordPress User Profile with Solid Security After that, click on the Configure button. On the next screen, youll find available two-factor authentication options. As you can see on the screenshot, you can set up your email to
receive a one-time code every time you log in. Or use backup codes. Or set up with an authenticator app. Two-Factor Authentication Methods in Solid Security You can set up the authenticator app just like we did with the Wordfence plugin. Its pretty simple to so. Adding a CAPTCHA (Completely Automated Public Turing test to tell Computers and
Humans Apart) to your WordPress login page strengthens security by presenting a challenge that distinguishes between genuine users and automated bots. CAPTCHA prompts users to complete a task, like identifying distorted text or images, preventing automated programs from gaining unauthorized access. This extra step significantly reduces the
risk of brute-force attacks, where hackers try multiple password combinations, thus enhancing the overall security of your WordPress site. You can easily add CAPTCHA to your WordPress login URL using security plugins. Login to your WordPress dashboard and go to Wordfence >> Login Security. After that, click on the Settings tab. Login Security
Settings on Wordfence After that scroll down to reCAPTCHA settings. Now, you need the reCAPTCHA V3 Site Key and Secret Key. Setting Up reCAPTCHA on Wordfence For that, you need to add your site to Google reCAPTCHA admin. You can read this documentation for the help. You can set up the CAPTCHA settings in quite a similar way. Go to the
Security >> Firewall page first and then click on the Configure tab. After that, click on the CAPTCHA option. CAPTCHA Settings in Solid Security Enable the CAPTCHA option by clicking the toggle. Then, you need to enter the site key and secret key as shown before. Thats it! Another method is to add Math CAPTCHA with Hide My WP Ghost to add
an extra layer of security to your WordPress login page. This helps prevent brute-force attacks where bots try to guess your password by attempting numerous logins with different combinations. For that, install and activate the Hide My WP Ghost plugin like any other WordPress plugin. With that, youll see Hide My WP menu on the left navigation.
Under it, go to the Brute Force settings. Go to Brute Force & Click on Use Brute Force Protection Under the Brute Force settings, activate the Use Brute Force Protection button. With that, youll see the page as shown below. Specify Math reCaptcha & Save the Changes Now, navigate to the Math reCAPTCHA option. Following that, you can set the
Max fail attempts, Ban duration, and lockout message. Once done, hit the Save button. With that, Math CAPTCHA is now activated! Now, any user attempting to log in will now need to solve a simple math problem before gaining access. Glimpse of Math reCaptcha on Login Its a typical habit that the majority of us leave our accounts open and
unattended. Sometimes something may close the browser without logging out of our accounts. Overall, this bad habit of ours can pose a security risk. Because hackers may find a chance to change your passwords or make unwanted changes to your account. Hence, you must always remember to sign off when youre inactive. Also, if youre using a
public computer or unsecured public Wi-Fi, then you must be even more alert. Unlike e-banking websites, WordPress doesnt have an auto-logout option when users are inactive. So, you need to implement this security measure using plugins like Inactive Logout. Inactive Logout WordPress Plugin As this plugin is free and straightforward to install,
upon activation, youll need to go to Settings> Inactive Logout. Then, simply set the idle timeout and add a logout message. Inactive User Logout Setting If youre running an online store or any site, then you would possibly need to create and use a custom login page. When you use a custom login page on your site, youll make it look professional and
help to create a promising brand for your users. The Hide My WP Ghost is free and easier to use a plugin for creating a custom login page on your WordPress site. Hide My WP Ghost Security Plugin All you have to do is install and activate it via Plugins > Add New from your WordPress Plugin Directory. Install & Activate Hide My WP Ghost Plugin
With that, youll see the Hide My WP menu added in the left navigation. Then, go to the Change Paths tab, and click on the Lite Mode tab. Navigate to Change Paths & Enable Lite Mode Tab Following that, youll see the prompt page as shown below, and click on the Continue option. Click on Continue Button Next, navigate to the Admin Security tab
and enable to Hide wp-admin, and Hide wp-admin From Non-Admin Users. Go to Admin Security & Enable to Hide the WP Admin With that, you can protect the admin area from unauthorized access. Further, allowing you to block many common security threats. Further, go to the Login Security tab to create a custom login path. For instance, lets add
customloginurl and also enable Hide wp-login php and Hide Login Path. And hit the Save button. Specify the Custom Login Path & Save Next, you can do a quick Frontend Test to check whether the paths are loading correctly or not. Conduct a Quick Frontend Test Further, you can also do a login test via your new URL page. Login Text Via New URL
Page This way, you can create a new URL for your loginpage and hide the default one.As a result, attackers cannot identify your websites point of entry. Sometimes when youre logging into your WordPress admin page, youll experience various issues. Here are some solutions to some common ones: Certain times youll remember your email address
correctly, but the password you just entered cant seem to work. Then you cant log in to your WordPress website. In that case, youll click on Lost your password? just below the login form. Lost your password? Firstly, WordPress will ask you to enter either your username or email address related to your account. Secondly, a link to change your
password will be sent to your corresponding email. If youre experiencing the Error Establishing a Database Connection error, then theres nothing to stress about as it is a pretty common issue. This usually happens when your site is unable to retrieve and display information from the database. This may prevent you from logging into your WordPress
admin dashboard. Database Connection Lost You can fix this issue by checking your login credentials. And then, confirm that they match the login credentials in your wp-config.php file with those in your MySQL Database. Cookies are small files stored in your browsers directory that store information like the websites name and a unique ID that
represents you as a user. So, sometimes you might not be able to log in due to cookies-related issues. Hence, you might get the following error: Error: Cookies are blocked or not supported by your browser. You must enable cookies to use WordPress. Similarly, if your browser cache isnt updated regularly, then youll view older versions of some files
that support WordPress. Fixing these issues is damn easy. Firstly, you would like to enable the cookies in your browser. Secondly, you would like to clear both your browser cache and cookies. Youll clear browsing data by pressing Ctrl + Shift + Del in Windows, and Opt + Cmd + E in Mac. Then, attempt to log in to your WordPress admin dashboard.
Find out WordPress cache plugins and WordPress cookie consent plugins if youre interested in them. Sometimes when youre making too many failed attempts to log into your dashboard, WordPress would automatically disable you from further logging in. If its happening because you have forgotten your password then, simply attempt to reset it.
Finally, read our article on how to make a website if youre a beginner. We hope this article has helped you with how to login to WordPress. We believe that you can now remember your WordPress login URL. Hopefully, you also have some ideas on how to protect your WordPress login from other intruders. If youve any further queries about WordPress
login, then please leave a comment below. Well try to get back to you as soon as possible. Further, read our other blogs on the best Captcha WordPress plugins and how to backup a WordPress site for free. If you like this article, then please share it with your friends and colleagues. Also, dont forget to follow us on Twitter and Facebook. Some of the
links on this article/page are affiliate links. If you click on such an affiliate link and purchase the product, well earn a specific percent commission from the seller. But it wont at all affect the price youll pay. The most important part of your WordPress site is the WordPress admin dashboard. Many people who are new to WordPress will often misplace
their WordPress login URL. This quick guide will show you how to login to your WordPress admin if you forgot the URL. The video below will answer the question How do I login to WordPress?. Dont have time for a video? keep reading below. You can login to the WordPress admin dashboard with the URL below: So if you have a new WordPress install
you can access your account at that URL. If you have WordPress installed in a subdirectory your login URL will include the subdirectory. For example yoursite.com/folder/wp-admin/. In addition to the /wp-admin/ URL you can access the WordPress login page with this URL: You can use the username and password you set when initially setting up
WordPress. Both of these URLs will log you into WordPress. WordPress login page If you forgot your WordPress password you can use the Forgot Password? link on the WordPress login page. Using the forgot password button will email you a one-time use link to change your WordPress password. Some security plugins will change your admin URL so
if /wp-admin or /wp-login.php does not work we recommend disabling security plugins via FTP or asking your web host to do it. If you get the error Error: Cookies are blocked or not supported by your browser. You must enable cookies to use WordPress. the issue is related to cookies being blocked, corrupted, or cleared too frequently. Cookies allow
your browser to remember login details, so if theyre not working properly, youll keep getting logged out. To fix it, try clearing your browsers cookies and cache, then logging in again. If that doesnt work, check if your browser is blocking third-party cookies for the site. You may need to allow them. With a little troubleshooting, you can resolve pesky
cookie-related login headaches. The easiest way to remember your WordPress login URL is to bookmark it in your web browser. Heres how to bookmark a page in most browsers: Google Chrome: Bookmarks > Bookmark This Tab Firefox: Bookmarks > Bookmark This Page Safari: Bookmarks > Add Bookmark Edge: Click the star icon to the right of
the address bar Once you bookmark the page in your browser youll have easy access to your admin in your browsers bookmarks. Add a login link with WordPress widgets: Once youre logged into your admin you can add a widget to your website that has a login link using the meta widget. This can be done by going to Appearance>widgets in your
WordPress admin dashboard. Once youre in the widgets area of your WordPress site you can drag the Meta widget to your sidebar (or footer widget area) to include a WordPress login link. Meta widget in the WordPress widget panel The Meta widget will include login, logout, RSS, and WordPress.org links. We also have a few additional guides if
youre looking to modify your WordPress login more. Changing your WordPress login URL is a great way to improve your sites security and to prevent bots from brute forcing your login page. This includes changing the design of your WordPress login by customizing your login page. Additionally if you want to hide your WordPress login page you can
follow our guide to changing your WordPress login URL. This can help prevent bots from finding your WordPress login page. If you have any questions about your WordPress admin login you can ask it in the comments below!
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